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Purpose: The purpose of this document is to outline the steps necessary to configure CQ/X for mobile operation 
in a state QSO party.  The Texas QSO Party will be used as the example. In a few of the steps it will be 
necessary to have the hardware powered on and connected to the PC. 

Getting Started: This document will be more meaningful if you have the program up and running so let's get that 
out of the way first. On starting the program you will have the option of resuming the previous contest or starting 
a new one. Select Start a New Contest and select the Texas QSO Party (TX-QSO-PARTY). On the resulting 
New Contest dialog specify that you will be an Inside Mobile operator. You can also fill in other information on 
the New Contest dialog at your option. Click on the ok button on the New Contest dialog and then enter an 
operator ID or elect the default N/A and click on the Apply button. This will take you back to the startup wizard. If 
you are ready to interface your hardware to CQ/X click on the Next button to get to the Port Assignments dialog.

Use the Port Assignments dialog to connect each piece of hardware via the appropriate port and with the 
appropriate baud rate. Once you've finished with that click Ok and you will be taken back to the startup wizard 
and will have the option to continue with the wizard by pressing Next. If you want to skip the remaining steps of 
the wizard click the Previous button and, since this document will walk you through the main steps, elect to Skip 
the Configuration Wizard. You will get a Validation request which you can just ignore for now by clicking on the 
Close button.

Overview: So now we're ready to get into the main steps of the setup. Here is an overview roadmap and brief 
description of the main steps. The data entered in these tasks will be preserved across a restart of the program 
so, for the most part, they are one time tasks needing to be repeated only if you decide a change is necessary.

1. Key assignments – used to specify the tasks to be carried out by certain assignable function keys
2. Message definition – used to define all of the messages to be used in the contest
3. Keying parameters – used to setup Auto CQ, Enter Sends CQ and other keying options
4. Radio parameters – used to setup radio band limits and some specialized parameters for specific radios
5. GPS parameters -  used to setup GPS parameters including update speeds, GPS logging, and GPS 

pass-through to a mapping program.
6. Waypoint definition – used to define waypoints that will be tracked by CQ/X
7. County line crossings –  used to define the points at which you plan to cross each county line. It allows 

CQ/X to provide estimates of the distance and time to next county

Key Assignments – This is performed using the menu item Keyer | Assign Function Keys to call up the 
Assigning Function Keys dialog. On that dialog you will see a listing of all the function keys F1-F12 along with 
combinations of function keys with Control, Alt, and Shift. Also included are some other keys such as INSERT, 
PLUS, PageUp, PageDown, etc. Next to each key will be a drop down containing a list of the assignable tasks. 
Selecting a task from the drop down will provide a brief description of the task. In order to get started you may 
want to use the button labeled Load Defaults to provide an initial set of assignments which you can then 
customize. Also in the later Operating section of these notes is a list of typical assignments and how they are 
used. After you have arrived at an assignment for all desired keys click on the Assign Keys button to implement 
that assignment. Note that, if desired, you can setup certain keys to emulate the NA logging program. You can of 
course always come back to the Key Assignments dialog and change the assignments – including in the middle 
of the contest.

Message Definitions -  This is performed using the menu item Keyer | Edit Message Template to call up the 
Editing Message Template dialog. On that dialog you will see a listing of all the user-definable messages. There 
is a Load Defaults button for loading in a set of messages specific to the chosen contest. That would be a good 
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place to start. You will want to change to your call sign at the very least. In the messages you will see some 
symbols like #, !, ^, @ which are used to denote places where variable message items are to be inserted. 

# is the symbol for current county
! is the symbol for next county
^ is the symbol for sequence number (of course this is not used in Texas QSO party)
@ is the symbol for the currently entered call sign

Each of the messages has a short name some of them obvious and others not so obvious.

• CQ is the message that will be sent by the <SEND_CQ> task to call CQ
• CQX is the message that will be sent by the <SEND_CQX> task to send the exchange.
• CQT is the message that will be sent by the <SEND_CQT> task as the thank you at end of a QSO
• SP is typically used to drop your call in for a search and pounce QSO
• SPX is the message for sending an S&P exchange
• QS0 is used as a short form of the CQT message and is tied to the [ key
• QS1 is used as another short form of the CQT message and is tied to the ] key
• QS2 is used as another short form of the CQT message and is tied to the \ key

Note that in order to activate the [, ], \ keys used with QS0-QS2 you need to enable the NA emulator using the 
Key Assignments dialog.  

Some not so obvious messages are the Q1-Q5 and A1-A5 messages which are used to request a fill (Q1-Q5) or 
to answer a request for a fill (A1-A5). These are tied to the individual components of the exchange which, in the 
case of the Texas QSO Party is CALL, RST, QTH. So, in that case

Q1(A1) will send (answer) request for call
Q2(A2) will send (answer) request for RST – not often used
Q3(A3) will send (answer) request for QTH

The requests for a fill are automatically sent based on incomplete exchange information when an attempt is 
made to log a contact. 

Note that once the messages have been edited you should click on the Update Template button to put the 
messages into effect. You can then view (but not edit) the messages on the Messages tab on the right hand side 
of the main display.  These messages will stay in effect until you modify them using the Keyer | Edit Message 
Template menu item.

When you close the Editing Message Template dialog and there are current county (#) or next county (!) symbols 
in the messages you will not be able to make a QSO until those symbols have been resolved into actual county 
abbreviations. This can be done either manually by typing a # sign into the QSO Entry window and selecting the 
county or by letting the program automatically detect the county. If you are using a GPS the latter would be the 
preferred method. In order for CQ/X to resolve the next county symbol (!) you must provide it information about 
the sequence of counties in your route. That will be covered in a later section on route planning.  

Keying Parameters -  The radio may be keyed by either using an external WinKey or the internal keyer 
contained in the radio. The former is a general method applicable to all radios and the latter, of course, only 
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applies to radios that have an internal keyer (presently that means the internal method only applies to the K3). To 
set the keying parameters you will need to have the relevant hardware device (WinKey or K3) interfaced to 
CQ/X. This is done through the Port Assignment dialog that can be reached from the menu items Connect/ 
Disconnect under the Radio or Keyer menus. Once either a radio or a keyer is interfaced use the Set 
Parameters or Set Radio Internal Keyer Parameters menu items to set up any desired Auto CQ, delay between 
Auto CQs,  and whether to resume Auto CQ following a QSO or a county change. Another keying parameter is 
whether pressing of the Enter key sends CQ (when the QSO Entry window is blank). That is set by clicking on 
the Send CQ With Enter Key menu item under the Keyer menu. Keying speed is another parameter and it can 
be set in a number of ways including the following, once a keying device has been connected to CQ/X.

• Type K=ss where ss is the desired speed into the QSO entry window followed by the Enter key
• Select the desired speed from the drop down box near the radio frequency readout on the main display
• Use PageUp/PageDown to increment/decrement the speed assuming that the PageUp/Down keys have 

been assigned this task

Radio Parameters – The general parameters applying to all radios are the operating min and max frequencies 
for each band which, once a radio is interfaced to CQ/X, may be set from the Radios | Set Parameters menu 
item. These are primarily used in search and pounce mode. For example if you are doing S&P from low to high 
frequencies in the band and want to start back at the low (min) operating frequency you can type F=L into the 
QSO entry window and the radio will be moved to the operating min frequency. Similarly F=H will take the radio 
to the max operating frequency. 

For the K3 additional configuration parameters may be set by clicking on the More button in the radio area. A 
small popup menu will appear from which you can access a radio display. On the K3 radio display is a Config 
button in the lower right hand corner near the RIT knob. Clicking on that button will bring up a dialog for setting 
additional parameters specific to the K3. These include: 

• Hold time for key presses via the mouse when using remote control of the radio
• Paddle speed (internal keyer speed) tracks the speed of an external WinKey
• CW Tuning Aid Always on when in CW
• Maintain Mode across a band change
• Tuning power reduction level and timeout
• Setting of Quick memories
• Preferred power settings based on antenna and mode

GPS Parameters – In order to set these parameters you will need a GPS interfaced to CQ/X. You can do this 
using the GPS | Connect/Disconnect menu item which will call up the same Port Assignments dialog that was 
used in interfacing the radio and keyer. Once the GPS is connected use the menu item GPS | Set Parameters to 
call up the Setting GPS Parameters dialog. The main GPS-related parameters you may want to set are:

• GPS Passthrough – this will allow passing GPS data from CQ/X to another program, such as a 
mapping program like Microsoft's Streets and Trips or Delorme Street Atlas. This communication will be 
performed over a virtual serial port(VSP) which is software that allows two programs that support serial 
communication to communicate over a pair of virtual ports configured as a null modem. VSP is not part 
of CQ/X and must be separately installed and configured. VSP Manager is an excellent version of this 
software that may be freely downloaded. Use Google to access and download it if you do not already 
have VSP software installed. 
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• Time Between GPS Updates – this is the time in seconds between processing of GPS data and 
updating of GPS data on the displays. I typically use the default of 10 seconds but the program may be 
set for faster updates if the PC can support it. Keep in mind that this determines to some extent how 
responsive the program will be when crossing a county line. For example at 70 mph you can cover about 
a quarter mile in 10 seconds. Using the C/L Alert Range parameter you can customize the program to 
use a faster update rate when it gets within the specified “alert range” of the next county line while using 
the normal update rate when it is outside the alert range.. 

• Record GPS Information – use this and choose what information to record if you want to record lat/lon 
associated information. I like to use the one labeled “In CQ/X QSL-Ready Format .... which allows 
creation of location-specific map based QSLs and Logs on a Map. If you use this option you will be 
asked to define a file for capturing this information. Use the Browse button to define the file. 

• Define Waypoints -  You can also use the Setting GPS Parameters dialog to define a set of waypoints 
which are simply places along your route whose distances from your current location are important and 
need to be tracked by CQ/X. Typically these might be the distance to important turns or highway 
changes, or a Saturday night stopping point for dinner or lodging. Of course these can not be completely 
defined until you have a route plan. You can use the dialog to define these points but it may be easier to 
just define these points in a text file and then import that text file using the Setting GPS parameters 
dialog. If you do it this way your waypoint file should have the following format with each waypoint listed 
on a separate row of the file.

WaypointName WaypointLatitude WaypointLongitude

where latitudes are listed as decimal degrees and are positive in the northern hemisphere and 
western longitudes are negative and also decimal degrees and the entries are space-delimited.

County Line Crossings File – If you want CQ/X to be able to provide real-time estimates of the distance and 
time to the next county you will need to tell it where you are planning to cross each county line. This is done in a 
text file containing a separate line for each crossing and, of course, requires that you have already decided on 
what route you will take. The format of each line is 

FromCty-ToCty HighwayID CrossingLatitude CrossingLongitude

where FromCty is the full name of the county you will be crossing from
ToCty is the full name of the county you will be crossing into
CrossingLatitude is the decimal latitude of the crossing point
CrossingLongitude is the decimal longitude of the crossing point

Since the entries are space delimited there should be no spaces in the county names. So for example the county 
Red River would be entered as RedRiver.

There are three ways to develop the crossings file. 
Crossing File Method 1: Use a mapping program like Streets and Trips that shows county lines 
Crossing File Method 2: Use the Crossing Tool from the CQ/X web site. 
Crossing File Method 3: You can draw your route on a Google Map and download information from that map to 
submit to CQ/X which will then analyze the map and determine your crossings file.

The main advantage to Method 2 is that the crossing lats/lons can be simply mouse-picked off of a Google map 
rather than entered by hand as is required in Method 1. A possible disadvantage to the latter two methods is they 
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both require an internet connection. To access the CQ/X crossing tool go to http://www.no5w.com and click on 
the Tools link and then select the state of Texas. There is documentation on the website that gives details on the 
remaining steps – see the link Developing a Crossing File Using Google Maps on the Documentation page or 
you can access the same document from the Help | Use Google Map to Create Crossing File menu item in the 
program. That document also explains how to do Method 3.

Once you have built the crossing file use the menu item QPTools | Build Plan from Crossings to import and 
validate the crossing file. Be sure to include each crossing of a county line in the file. For example suppose you 
cross from Travis to Williamson along a certain highway, stop in Williamson, and then cross back into Travis on 
the same highway. That requires two entries in the crossing file.

That completes the main steps in setting up the software for a mobile operation. Obviously you should save any 
created files in locations and with names that make it easy to remember where they are. For the most part the 
information created in the above steps is carried over automatically across a shutdown-restart of CQ/X. But 
sometimes you need to reload the information or you may want to have multiple versions of some of the files. In 
that case you need to know where to find them. A good approach is to define a single directory where all of your 
files for a particular trip will be located.

Optional Data – Here is some optional data that you might want to supply 

Logs from Previous QSO Parties – If you have logs or just simple lists from previous QSO parties you can use 
them as a database for partial call lookup and for auto-fill. The parser will read the specified file and pick up the 
last call sign on each line and any information that follows it. So any Cabrillo-formated log can be used but ADIF 
files may pose a problem depending on how they are formated. You can load the data from these files into CQ/X 
using the Options menu items Auto-Fill Previous Exchange Info and Show Similar Calls During Entry. 

User-Defined Help – If you have information that you would like to have available from the Help menu during 
the contest you can add it to the Help menu using the Options | Configure User-Supplied Help menu item. 
These could be pdf files of certain manuals, bmp files of certain screen shots, html files, simple text files. 

Operating as a Mobile - Here's a summary view of how to operate as a mobile. It assumes a certain set of 
typical key assignments and key combinations for using CQ/X in a mobile QSO party environment have been 
defined. 

Key Assignments – Single Function Keys:
Key Description
F1 Send the CQ message

F2 Send the exchange message CQX – same for Run and S/P modes

F3 If all items are present in the check grid this key will send the thank you message CQT and log the 
contact. If there are missing items F3 will send the associated request for fill (Q1/Q2/Q3).
Following the CQT message the CQ message or the QRZ message will be sent depending on whether 
QRZ scheduling is setup and, if so, on the current QSO rate.

F4 Send the worked before message CQD – generally just work the dupes so this is rarely used.

F5 Send your call for S&P or for just responding to request for your call.

F6 Access the Operator Notes dialog for recording a note. 
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F7 Silently log the QSO

F8 Buffer call sign of a second caller while working the first caller (see note at end on how to use) 

F9 Sends the Next County message. e.g. NEXT HARR IN ABT 3 MINS

F10 Homes the cursor and focus to the QSO Entry Window – CQ/X main display must have the focus

F11 Access the Waypoint Tracking Window

F12 Access the log display. Typically this is used to make a revision using the following steps. 
1. Press F12 
2. If necessary use up arrows to cursor to the QSO you wish to revise and press Enter
3. In the resulting dialog type in the revision and press Enter
4. The previous step revises QSO, closes the revision dialog, and initiates the CQ message 

Key Assignments - Key Combinations
Keys Description
Shift + Spacebar[1] Sends CQ. Little finger holds left hand shift key and thumb presses space bar.

Shift + Enter[1] Sends last word in QSO Entry panel followed by a question mark

Shift + Arrow[1] Shift + Left Arrow moves RIT down. Shift + Right Arrow moves RIT up.[1]

Enter [1] Same as F3 if all items are present in the check grid.  

Ctrl + N Sends the Next County message. See F9 above.

Ctrl + T Opens the Multiple Waypoint Tracking Window – also see F11

Ctrl + W Clears the QSO Entry panel 

Ctrl + F1 Access More button for more radio or keyer controls 

Ctrl + F2 Access Score in left hand page control – vertical score arrangement

Ctrl + F3 Access GPS page

Ctrl + F4 Access Similar Calls page – partial call check

Ctrl + F5 Send Query Q1 – CALL? Or whatever message is set up as Q1

Ctrl + F6 Send Query Q2 – RST? Or whatever message is set up as Q2

Ctrl + F7 Send Query Q3 – QTH? Or whatever message is set up as Q3

Alt + F1 Decrement Band

Alt + F2 Increment Band

Shift F1 Move Up the Band by 5 KHz

Shift F2 Move Down the Band by 5 KHz

Shift F3 Move Up the Band by 1 KHz

Shift F4 Move Down the Band by 1 KHz

Shift + F5 Send answer A1 – your station call or whatever is set up as A1
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Shift + F6 Send answer A2 – your RST or whatever is set up as A2

Shift + F7 Send answer A3 – your QTH or whatever is set up as A3

Shift + F12 Remove the last QSO in the log. You will be asked if you really want to do this.

Page Up Increment keying speed – use Keyer | Set Parameters to set increment size

Page Down Decrement keying speed – use Keyer | Set Parameters to set increment size

ESC Closes any focused dialog if there is one. Otherwise it stops the keyer.
1. Of course this is only applicable to those radios that have RIT controllability.

From the QSO Entry Panel
Key Entry Description
K=SS (e.g. K=35) Sets the keying speed to SS

F=ffffffff (e.g. F=14040000) Sets the frequency to fffffffff

F=L Changes frequency to low band edge defined in radio parameters

F=H Changes frequency to high band edge defined in radio parameters

# Brings up a dialog from which you can manually set the current county

Enter If no fills are needed. clear entry window, log QSO, and send CQT message

[ Clears entry window, logs QSO, and sends the QS0 message.

] Clears entry window, logs QSO, and sends the QS1 message.

\ Clears entry window, logs QSO, and sends the QS2 message.
The keys [,],\ shown for use with messages QS0-QS2 are dedicated to those messages and are intended for 
alternate CQT confirmation/QSL messages at the end of the QSO. They each result in sending their associated 
message and logging the QSO. In order to enable them it is necessary to enable the NA Emulator.

Making a Run QSO
1. Send CQ using either F1 or Shift + Enter, or the Enter key if you have selected "Send CQ with Enter 

key" under the Keyer menu.
2. Type the responder's call in the QSO Entry window
3. Send CQX (exchange message in CQ mode) using either F2 or the Enter key
4. Type the responder's exchange info in the QSO Entry window
5. Send CQT using either F3 or the Enter key
6. To change something on the QSO Entry window just type it as the right most item of that type and view 

the Check Grid to verify that the entry was interpreted properly
7. If there is uncertainty about a call you can view similar calls in the Similar Calls window

Buffering a Second Caller During a Run
Assume you call CQ and copy two callers (CALL1 and CALL2) and wish to respond to CALL2 immediately after 
logging the contact with CALL1 rather than sending the normal CQT message. Use of the Buffering Key 
(Alt+Enter key combination, or an assigned function key), allows CALL2 to be buffered for processing and the 

 
CQ/X Client                                               User Documentation                                                 7



NO5W                                   Setup and User Notes for the Mobile Operator              CQ/X Client

contact with CALL2 to be automatically initiated at the end of the CALL1 QSO using the CQN message. The only 
requirement is that the QSO Entry line should have one of the following possible formats when the Buffering Key 
is pressed.

CALL1 CALL2
CALL1 EXCHANGE1 CALL2
CALL1 CALL2 EXCHANGE1
CALL1 SUBEXCHANGE1 CALL2 SUBEXCHANGE2

In other words CALL2 must be the rightmost call on the entry line. 

In the above, the Buffering Key must be pressed prior to logging the contact with CALL1 (otherwise CALL2 will 
be regarded as a correction to CALL1). 

Once the Buffering Key is pressed the entry line will become

CALL1
CALL1 EXCHANGE1
CALL1 EXCHANGE1
CALL1 SUBEXCHANGE1 SUBEXCHANGE2

respectively and CALL2 will be saved in a next call buffer.

On logging the contact with CALL1 the next call buffer will be examined and, if it contains a call, that call will be 
copied into the entry line and message CQN will be sent. If the next call buffer is empty then the normal CQT 
message will be sent. So an appropriate message for CQN, when operating mobile in a QSO party where signal 
report and county are the exchange items, would be something like: NOW @ 5NN #.

So here is one of the possible sequences assuming F8 has been assigned the role of Buffering Key:

1. Press Shift+Spacebar to call CQ
2. When W5ZZ and W5XX respond type W5ZZ in the QSO Entry window
3. Press Enter to respond to W5ZZ
4. While the exchange is going out to W5ZZ type W5XX to the right of W5ZZ 
5. Type the exchange information from W5ZZ to the right of W5XX
6. Press F8 to save W5XX in the next call buffer
7. Press Enter to log the contact with W5ZZ. This will copy W5XX to the QSO Entry window and send the CQN 

message with W5XX as the call.
8. Type the exchange information for W5XX and press enter to log the contact with W5XX and to send the 

CQT message. 

Note also that Steps 6 and 5 could have been interchanged.

Editing Messages
If you need to edit your messages use the following steps

1. Use menu item Keyer | Edit Message Template to change your messages
2. Once satisfied with the messages click on Update Template
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3. You will see the new messages appear in the message array on the right hand side
4. If you have # or ! symbols in your messages you will get a message box asking to resolve them and you 

will not be able to make a QSO until these symbols are resolved. If you are using a GPS click on the 
button labeled Auto GPS Auto.
Important Note: At this point you should wait for the GPS to resolve the # and ! into current and next 
counties. Make sure you do not have any non-blank characters in the QSO Entry window – if you do the 
program thinks you are in the middle of a QSO and will not resolve the # and ! until the QSO Entry 
window contains only blanks.  

Interpreting GPS Data in the QSO Entry Area
Often you need to use the left hand paging control for display of information other than that from the GPS. For 
example you might want to view the score. For this reason essential GPS information is presented in the QSO 
Entry Area as shown below.

Here the operator is currently in SPAT county and has been there for 2 minutes and 27 secs. The next county is 
NUEC which is estimated to be 11.42 miles from the operator's current location and at current speed will be 
reached in about 14 minutes and 22 seconds. Also in the above the operator started out thinking he was working 
K5NG but then determined it was really K5NZ.

Using the Multiple Waypoint Tracker
If you're helping the driver with the route it is good to know what the next waypoint/turnpoint is and how far it is to 
that point. It is difficult to remember all of the waypoints and where they fit in the route. The multiple waypoint 
tracker is provided to assist in this. A screen shot is shown below. Here's how to use it:

• Press the assigned function key (e.g. F11) to call up the Multiple Waypoint Tracker
• Select whether to track the Closest N waypoints or All Waypoints within X miles
• Once those selections are made the resulting list of waypoints meeting your criteria will be updated
• The list will show the name of the waypoint, distance to the waypoint, and color coding will indicate 

whether the distance is increasing (red) or decreasing (green). 
• The list will be arranged in order of increasing distance.
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Using the K3 Control Interfaces

There are two K3 Remote Control interfaces, a large or Full interface, and a small or control subset interface. 

Full K3 Interface - The Full interface consists of controls embedded in a screen shot of the K3 front panel and it 
works in much the same way as the actual panel using mouse clicks with the left mouse click serving the role of 
a press of a key and the right mouse serving the role of a press and hold of a key. This interface may be left 
open at all times. However, a major disadvantage of this interface is the amount of screen real estate that it 
requires. Hence the small K3 interface. 

Small K3 Interface – The small K3 interface contains a subset of the most often used controls in a compact 
format as shown in the screen shot below. Note that there is a single slider control that is shared between all of 
the controls that require continuous adjustment across a range of values. These controls include:

• VFO A  and VFO B frequency
• RIT
• Audio Frequency Gain (AFG), Radio Frequency Gain (RFG)
• Filter Bandwidth XFIL
• Keying Speed (SPD)

To use the slider to control any of these do the following: 
1. first click on its associated button.
2. This will assign the slider to that control and will show the limits on each end of the slider
3. Drag the slider with the mouse or use the left and right arrow keys to adjust the slider
4. When you are done click on the Release button to release the slider.
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Other controls on the Small K3 Interface operate with a single click. Colors on some of the buttons will show 
whether the control is currently on (green) or off(red). In the case of AGC yellow indicates medium speed AGC. 

SWR Button - When changing bands or whenever you want to check the SWR clicking on the SWR button will 
reduce power to a specified value (configured using the Full interface), put the automatic antenna tuner into 
bypass mode, determine and display the SWR in the clock window, and then will return power and antenna tuner 
to their previous states.

Clock – The clock can be selected to show either UTC or the amount of time remaining in the session. The latter 
requires that you define the sessions. This is usually done at the beginning but may be done at any time.

Full Button – The Full button closes the K3 Control Subset window and opens the Full K3 Control window.
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